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ISYS Utilities window
The ISYS Utilities window is for maintaining and configuring ISYS databases. Select the
options you want from the menu bar.
The major part of the window is used to show the progress of the various maintenance 
activities.
See Also:
Database overview
File formats
Indexing rules
Database options
Update
Reindex
Optimize
Statistics
Word frequency
List Documents
Common words (viewing)
Query by concept
Restrictions
Auditor



Database overview
The database is the most important part of ISYS, and its correct maintenance is very 
important to the smooth operation of ISYS. 
An update scans the documents on your hard disk and determines which ones have 
been changed, added, or deleted since the last update. It then updates the database so 
that it accurately reflects the documents on the disk. You should perform an update at 
regular intervals, for instance, daily, at a maximum weekly if your documents do not 
change often.
A reindex completely reconstructs the database files, and then performs an update to 
the index. You should perform a reindex if the database becomes damaged or corrupt, 
or if you change the common words, significant, or insignificant characters lists. The 
reindex writes the changes into the database files.
Most other options can be changed without a reindex becoming necessary - the 
changes will come into effect at the next database update.
Optimize is a special type of reindex that optimizes the database for size and speed of 
access. However, because it is somewhat slower to actually run an Optimize than a 
normal reindex, you are given the option between the reindex and Optimize.
An Addis a special type of Update that scans the directories looking for only those 
documents that have been added since the last update.    This is a quick method of 
adding new documents - you will still need to use the Update facility for integrating any 
changed or deleted document references.
See Also:
Setup Wizard
File formats
Indexing rules
Database options



Selecting a database
To select a database, select the File menu, then the Select Database item.    ISYS will 
show you the Select Database Window.    You can use this to select a drive and 
directory.
If there is an ISYS database present in the directory you have selected, its 
name will be shown in the top box on the window.
When the window is showing the database you want to work with, choose the
OK button.



Setup Wizard
Setup Wizard is used to configure a basic set of database rules for your database. If 
you have created any complex rules with the Indexing Rules window you should not use
this procedure.    Any complex rules you have configured will be lost if you save the 
Setup Wizard configuration.
In the Where would you like your index.. window, select the directory where you wish 
your index filesto reside.
In the "What types of documents.." window, select the file formats you have by clicking 
on each type so that there is a check mark next to it.    ISYS will have already located 
and checked off one file format on your system.
In the "Under where are your documents ..." window ISYS will have already selected a 
default directory.    Use the Add another directory button to choose another directory 
from the directory selection box.    Use the Remove directory button to delete directories 
from the list.    The directories selected will be searched for documents to be indexed.
In the How would you like to name... window enter a meaningful name for the database. 
The Add index to Catalog button should be checked if you wish the database to be 
added to the Catalog.
See Also:
Database options
File formats
Indexing rules
Database overview



File formats
The File Formats window is used to select the types of documents that you have on 
your hard disk(s). To maintain the file formats, select the File menu then the File Types 
item.
In the "File formats installed" box, select the file formats you have by clicking on each 
type so that there is a check mark next to it. 
See Also:
Indexing rules
Database options
Database overview



Indexing rules
To add or change a database rule, select the File menu, and then the Indexing Rules 
item. The Indexing Rules window is used to add, change and display the indexing rules 
for each disk drive and directory.
To create or view the rules for a drive, select the appropriate drive button.
The "Rules" box (on the lower left of the window) shows you each rule for the selected 
drive. The directory and file pattern for the rule are shown here as well as on the status 
line at the bottom of the window. The file patterns are normal DOS file patterns, 
however, the directory patterns are:

dirname\ filename.ext
Include or exclude just this directory and file pattern

dirname\**\ filename.ext
Include or exclude documents matching the file pattern in and under this directory

dirname\*\**\ filename.ext
Include or exclude documents matching this file pattern under, but not in, this directory.
The "Directories" box (the lower middle part of the window) displays the directories on 
the selected drive. To create a rule for a directory, select the directory in this box, then 
click on the Create button below it.
The "Files" box shows you the files in the currently selected directory. To create a rule 
for a file, select the file in this box, then click on the Create button below it.
See Also:
File formats
Database options
Database overview



Create rule - directory rule
From the Indexing Rules window, select the directory to index from the directory list in 
the "Directory" box. Then, click on the Create Rule button below the "directory" box. The
Create Rule window is shown to you.
Select the options you want for the directory in this window.
The options are explained below:

Create a rule to ...
Include documents in <directory>

Use this to include documents in the current directory, but not any documents in any 
sub-directories.

Include documents in & under <directory>
Use this to include documents in the directory and any sub-directories of this directory.

Include documents under, but not in <directory>
Use this to tell ISYS that you want to index documents in the sub-directories of this 
directory, but not any documents which are in the directory itself.

Exclude documents in <directory>
Use this to tell ISYS not to include documents in this directory. Documents in sub-
directories may be included in the index if there are other rules which apply to them.

Exclude documents in & under <directory>
Use this to tell ISYS not to include any documents in this directory or any of its sub-
directories.

Exclude documents under, but not in <directory>
Use this to tell ISYS not to include any Documents in any sub-directories of this 
directory. Documents in this directory may be included in the index if there are other 
rules which apply to them.

Using ...
Select the file type that the documents in this directory are in the "Using ..." box, unless 
the rule is an exclude rule, as file types are unnecessary.
The file types displayed are the file types you selected with the Select File Types 
window. If you select "Best Guess" ISYS will try to automatically work out the format of 
the documents.

Document Options
Plain - This is the default setting to indicate that your documents are regular text files 
with no special formatting as indicated below.
Ventura - If you use Ventura Publisher, this option alerts ISYS to the possible inclusion 
of the special Ventura paste up markers.



Hardspaced - If your documents contain hard returns at the end of each line, use this 
option to indicate that two hard returns denote a paragraph break.
Doublespaced - If your documents are entirely doublespaced, i.e. two hard returns at 
the end of each line, use this option to indicate that three hard returns denote a 
paragraph break.
Presentation Quality
Speed - Use this option to ensure that ISYS will perform at optimum speed during 
indexing and document browsing.
Quality  - Use this option if you wish ISYS to index your documents using WYSIWYG 
document formatting.    This option will increase the indexing time and the time taken to 
open a document for browse.    However during browse, the document will more closely 
resemble how it looks in the word processor.    This would be of particular value if your 
documents contain a large number columns, tables, etc.

Document pattern
Type the pattern for the Documents you want this rule to apply to. This is a normal DOS 
file name specification..

Directory pattern
When this setting is combined with the document pattern it gives the specification for 
the rule, which is displayed in the Indexing Rules window. The directory patterns are:

dirname\ 
include or exclude just this directory

dirname\**\ 
include or exclude documents in and under this directory

dirname\*\**\ 
include or exclude documents under, but not in, this directory
See Also:
Create rule - file rule



Create rule - file rule
From the Indexing Rules window, select the file to index from the file list in the "Files" 
box. Then, click on the Create Rule button below the "Files" box. The Create Rule 
window is shown to you.
Select the options you want for the file in the window.
The options are explained below:

Create a rule to ...
Include <document>

Use this to include only the selected document in the index.
Include *.<ext> in <directory>

Use this to include documents of the matching extension type in the current directory, 
but not any documents in any sub-directories.

Include *.<ext> in & under <directory>
Use this to include documents of the matching extension type in this directory and any 
sub-directories of this directory.

Exclude <document>
Use this to include only the selected document in the index.

Exclude *.<ext> in <directory>
Use this to tell ISYS not to include documents of the matching extension type in this 
directory. Documents in sub-directories may be included in the index if there are other 
rules which apply to them.

Exclude *.<ext> in & under <directory>
Use this to tell ISYS not to include any documents of the matching extension type in this
directory or any of its sub-directories.

Using ...

Select the file type that the documents in this directory are in the "Using ..." box, unless 
the rule is an exclude rule, as file types are unnecessary..

The file types displayed are the file types you selected with the Select File Types 
window. If you select "Best Guess" ISYS will try to automatically work out the format of 
the documentDocument Options
Plain - This is the default setting to indicate that your documents are regular text files 
with no special formatting as indicated below.
Ventura - If you use Ventura Publisher, this option alerts ISYS to the possible inclusion 
of the special Ventura paste up markers.
Hardspaced - If your documents contain hard returns at the end of each line, use this 



option to indicate that two hard returns denote a paragraph break.
Doublespaced - If your documents are entirely doublespaced, i.e. two hard returns at 
the end of each line, use this option to indicate that three hard returns denote a 
paragraph break.
Presentation Quality
Speed - Use this option to ensure that ISYS will perform at optimum speed during 
indexing and document browsing.
Quality  - Use this option if you wish ISYS to index your documents using WYSIWYG 
document formatting.    This option will increase the indexing time and the time taken to 
open a document for browse.    However during browse, the document will more closely 
resemble how it looks in the word processor.    This would be of particular value if your 
documents contain a large number columns, tables, etc.

Document pattern
Type the pattern for the documents you want this rule to apply to. ISYS automatically 
makes this the extension of the selected files, but you can change it if you want. For 
instance, if you wanted only your .DOC files to be included, type *.DOC.

Directory pattern
When this setting is combined with the document pattern it gives the specification for 
the rule, which is displayed in the Indexing Rules window. The directory patterns are:

dirname\ 
include or exclude just this directory

dirname\**\ 
include or exclude documents in and under this directory

dirname\*\**\ 
include or exclude document under, but not in, this directory
See Also:
Create rule - directory rule



Update
The database must be regularly updated so that it accurately reflects the contents of 
your documents.
To update the database, select the Update menu. ISYS shows you the Update window.

Presort documents prior to indexing
Normally ISYS displays the documents in the default database order i.e. the most 
recently indexed documents appear first.    If you want your documents sorted by 
another criteria, click on the Presorting Options button to view the list of choices.    
If you generally wish to have your documents presented in a particular order during 
queries (other than the default database order), then it is more efficient to pre-sort the 
documents prior to indexing rather than at query time.
ISYS shows you the progress of the update in the ISYS Utilities window.
See Also:
Reindex
Optimize
Database overview



Reindex
When your ISYS database becomes corrupted or otherwise damaged, or if you are 
upgrading from another version of ISYS, or if you have changed certain database 
options or rules, you must reindex the database. A reindex completely recreates all the 
database files, scans your hard disk for documents, and updates the index.    
Sometimes, if your database contains many documents that have been modified or 
deleted, it is more efficient to do a Reindex rather than and Update, because during the 
Update process ISYS has to first remove all references to those changed and deleted 
documents prior to reindexing the changed documents.
To reindex the database files, select the Utilities menu.
ISYS shows you the progress of the reindex in the ISYS Utilities window.
See Also:
Update
Optimize
Database overview



Optimize
You can enhance the performance of the database by performing an Optimize. This 
rebuilds the database index and optimizes it for both disk space and speed of access.    
This procedure is normally only recommended if you intend to publish your database.    
A Reindex is usually sufficient for removing slack bytes from the index files.
You will have to have enough free disk space to perform an Optimize. In practice, this is 
as much disk space free as the database files currently occupy.
To Optimize the database, select the Utilities menu, and then the Optimize item.
ISYS shows you the progress of the Optimize in the ISYS Utilities window.
See Also:
Update
Reindex
Database overview



Add
Use the Add function to incorporate references to the database for new documents only.
To use the Add function, select Add from the Utilities menu.
The Add feature is intended for use as a quick method of incorporating new documents 
when you dont have time for a full Update.    The Update facility will still need to be run 
to incorporate references to documents which have been changed or deleted.
See Also:
Update
Reindex
Optimize



Statistics
Use the statistics to obtain an overview of the database and its contents. To look at the 
database statistics, select the Utilities menu, and then the Statistics item. ISYS compiles
the statistics for the current database and shows them to you in the ISYS Utilities 
window.
This shows you, in order from the top:
· the number of documents in the database
· the total number of words in all the documents
· the number of common words
· the number of words which are included in the database index
· the total number of different words in the database
· the characters which have been defined as significant

(when the database was created or last reindexed)
· the characters which have been defined as insignificant 

(when the database was created or last reindexed)
· the size of the three index files
· the amount of slack bytes of the index files B and C
· the percentage of slack bytes in the index files (at say 15% a 

Reindex would be recommended to recover the space)
· the directory where the database is located
See Also:
Word frequency
List documents
Common words (viewing)
Database overview



Word frequency
The word frequency report lists the words that are indexed in the database and how 
often they occur. This is of interest when designing a database, since the frequency of 
words highlights possible common word candidates, synonyms, etc. Peculiar words also
show up any potential problems with significant and insignificant characters. 
To view the word frequency, select the Utilities menu, and then the Word frequency 
item. ISYS shows you the Word Frequency window. Enter the minimum number a word 
has to occur and the characters the words must start with to be included in the report.
ISYS will compile the list and display it in the ISYS Utilities window.
See Also:
Statistics
List documents
Common words (viewing)
Database overview



List documents
To view the list of documents held in the database, select the Utilities menu, and then 
the Document List item. ISYS shows you the Document List window:
Choose the sort method from one of the three radio buttons. You can choose:
· Reverse chronological order
· Chronological order 
· Alphabetical order 
To view the documents in the order they are in the database, don't select any of the 
radio buttons.
You can also choose to only view those documents which start with certain characters 
by entering them into the "Document names containing the characters" field. 
Click on the OK button, and ISYS will compile the list and display it in the ISYS Utilities 
window. This list shows you the database document number, the format type of the 
document, the number of words in the document, and the path and file name of the 
document. At the bottom of the list ISYS shows you the total number of documents and 
total number of words in the database.
See Also:
Statistics
Word frequency
Common words (viewing)
Database overview



Common words (viewing)
This common words list shows you the common words as they apply to the database 
now (that is those that were defined when the database was created or last reindexed). 
Note that these may have been changed with the Common Word List window since the 
last reindex. However, the new list will not apply until a reindex is performed.
To view the list of common words, select the Utilities menu, and then the Common 
Words item. ISYS builds the list of common words and displays them to you in the ISYS
Utilities window.
You cannot edit the list in this window. Editing the common words is performed with the 
Common Word List window.
See Also:
Common words (maintaining)
Statistics
Word frequency
List documents
Database overview



Query by concept
To maintain the concept tree, click on the Concepts menu. ISYS will show you the 
Query by Concept window, with any part of the tree previously entered displayed.
For information on how to use concept trees when running a query, see the Query-by-
Concept help entry in ISYS Query help, or consult your manual.
You can add, edit, delete, change the level of, search for or print components of 
concepts.
See Also:
Concept Tree Overview



Concept tree overview
Using the concept tree, you can set up the equivalent of a corporate thesaurus, a 
database table of contents, or simply an outline of the contents of the database. For 
information on how to use concept trees when running a query, see the Query-by-
Concept help entry in ISYS Query help, or consult your manual.
Concept trees are useful to new users to find out what sort of information generally is 
available in a database. They let you, the database administrator, draw a conceptual 
map of the information in the database, and provide a number of relevant working 
queries for users to run on the database.
The concept tree is organized hierarchically or in a "tree" format. The highest levels of 
the tree are for the most general categories, with each subsequent level down 
becoming more specific:

Art movements
--Modernism
          --Impressionism
          --Expressionism
          --Cubism
--Postmodernism
          --Pop art
          --Conceptual art

Art Theory
--Structuralism 
    ...

Thus, using our example above, if you want information about art movements generally,
you can use the concept "Art movements". The concept can be set up to also search for
the concept levels below it: "Modernism", "Postmodernism", "Impressionism", etc, 
because these are all "art movements".
See Also:
Query by concept



Adding a concept
To add a concept to the tree, click on the Add button. ISYS shows you the Concept 
Entry window. Enter the options you want here. Click on OK to save the new concept.
If the new concept in not in the position you want, you can change the level of the 
concept. 
The options in the Concept Entry window are:

Concept name
The concept name.

Query
Enter the query command for the concept. Enter this as if you were typing the query into
the Command-Based Query window in ISYS Query. The command based reference 
contains the details of each command operator.

Options: Include all lower levels
If you want to include the lower levels of a tree in the query, click in the "Include all lower
levels in query" box. This means that if this concept has any sub-concepts, the sub-
concept's query will be included in this query.

Options: Filters... button
You can filter the results of a query in order to make your document list more 
manageable, or to exclude documents or paths of your choice.
If you enter a filter, it will temporarily replace, for the duration of the query, any existing 
query filters that you or any users set up in their preferences.

Description
The description of the concept. Be as detailed as possible as users will use this 
description as a guide when browsing the concept tree.
See Also:
Query by concept
Editing a concept
Deleting a concept
Changing the level of a concept
Finding a conceptPrinting Concept Trees
Concept tree overview



Editing a concept
To make changes to a concept, click on the concept you want to edit from the Query by 
Concept window and click on the Edit button. ISYS will show you the Concept Entry 
window with the options for the concept in it.
Type the changes that you want to make. See Adding a concept for an explanation of all
the selection boxes.
When have finished making your changes, click on the OK button. If you want to 
abandon your changes, click on the Cancel button.
See Also:
Query by concept
Adding a concept
Deleting a concept
Changing the level of a concept
Finding a conceptPrinting Concept Trees
Concept tree overview



Deleting a concept
From the Query by Concept window, click on the concept you want to delete from the 
tree and then click on the Delete button. ISYS will only delete the concept that you 
selected. Any concepts that are lower in the hierarchy will remain.
See Also:
Query by concept
Adding a concept
Editing a concept
Changing the level of a conceptPrinting Concept Trees
Concept tree overview



Changing the level of a concept
Use these buttons (pictured above) in the Query by Concept window to change the 
position of concepts in the tree. To move a concept, click on the concept that you want 
to move and click on the appropriate button.
The left and right arrow buttons change the level of a concept. The left arrow moves the 
concept up a level. The right arrow button moves the concept down a level.
The up and down arrow buttons move the concepts up and down the tree within the 
same level.

See Also:

Query by concept

Adding a concept

Editing a concept

Deleting a concept

Finding a conceptPrinting Concept Trees

Concept tree overview



Printing Concept Trees
If you wish to print the various components of a concept tree, from the Query By 
Concept window, click on the Print button.    A selection list will display from which you 
can choose to print the concept name, the concept queries, query descriptions, lower 
levels of the queries and any filters that apply to queries.
See Also:
Query by concept
Adding a concept
Editing a conceptChanging the level of a concept
Deleting a concept
Finding a concept
Concept tree overview



Finding a concept
If your concept tree is large, it is easier to use find rather than scrolling through the tree. 
From the Query By Concept window, click on the Find button. ISYS will show you the 
Find concept window.
Enter the string of characters that you want to search for and click on the OK button. 
ISYS will highlight the next concept that contains the string of characters in the Query 
by concept window.
After ISYS has completed the find, you can use the Next button to find the next concept 
that contains the string of characters that you entered. Click on the Next button. ISYS 
will highlight the next match.
See Also:
Query by concept
Adding a concept
Editing a concept
Deleting a concep
Changing the level of a conceptPrinting Concept Trees
Concept tree overview



Database options
To change the database options, click on the Options menu. The options are arranged 
in card tab form.    Choose the tab of the group of options you wish to define.
The options are:

Database name
Type the name for this database in the "Database Name" field.

Characters & Words
· Special Characters - enter any characters you want to make significant into the 

"Significant characters" field, and any you want to make insignificant into the 
"Insignificant characters" field.    Any character that is not defined in either of the 
above categories is regarded by ISYS as a punctuation character. These serve to 
indicate the end of one word and the beginning of a next. 

· Common words are not included in the ISYS database to save disk space. If you 
want to treat pure numbers as common words, select the "Treat pure numbers as 
common" check box.      To edit the list of common words, click on the Edit List button.    
· If you change the common words or the special characters you will have to 
reindex the database for the changes to take effect.

Indexing options
· Intelligently recognize/process dates.    Check this option if you want ISYS to 

intelligently recognize dates expressed in a variety of formats.    Note that selecting 
the Intelligent Date Handling option will slightly increase the size of your indexes, the 
exact amount depending on the nature of your data. Unless your data is mostly 
dates, the increase in index size should not be significant.    Enabling the feature may 
also slightly reduce indexing performance.

· Index dots when embedded in words or numbers.    Use this option for smart dot 
handling, wherein dots are significant in cases like 3.2.12, but not significant at the 
end or start of a word.

· Index filenames.    If you choose to index filenames, ISYS will allow you to search for 
files by their names, extensions, or any portion thereof.    In effect ISYS will actually 
index each portion of the filename as though it were a word located at the top of the 
document.

· Fuzzy precompensation for OCR/scanning errors. The use of this option is only really
appropriate when you know your source data is likely to have a high proportion of 
errors as a result of being captured by means of OCR/scanning (optical character 
recognition). The use of this feature will slightly increase your index size and indexing
time.
Changes to handling of Dates, Dots and Fuzzy precompensation will require a 
reindex of the database for changes to take affect.

· Concurrency.    If you want to allow query users to query the database while the index
is being updated, select the "Allow query users" check box.



You must not change the Update option while there are query users active. Also, you 
must be running a SHARE compatible LAN for concurrent access to work, or have 
SHARE.EXE running in the background. 

· Document update latency    The document latency determines how old (in minutes) a 
document must be before it is considered in the indexing process. This value may be 
changed without having to reindex the database.
Annotations

· Searchable/Indexed Annotations.    If selected, ISYS will automatically detect and 
index any annotations that have been created for documents in the database.    Only 
the text annotations are indexed    not hyperactivities, images or linked queries.

Because this option affects which files will and will not be indexed (much like an 
indexing rule), rather than affecting how previously indexed documents should be 
read (like date handling or dot handling), you can change it without reindexing the 
database. Changes will just be reflected in the next UPDATE run, just like a rule 
change.

· Annotaton Storage.    If you want the annotations files to be stored in the same 
place as the document the annotations are for, click on the "Same as document" radio 
button. If you want the annotation file to be stored in a specified drive, click the "On 
nominated drive" radio button, and    type the drive and path into the box to the right of 
the button description. 

If you choose another drive, ISYS will "mirror" the database directory structure on that 
drive, creating directories as needed. 

Document titles
The document title can be either the first non-blank line of the document or another line 
can be defined as the title. To change the title line, enter the line number into the "After 
line number" field. You can also specify a string that will occur in the title line. Enter the 
string into the "That contains the string" field. 
For example, if you are indexing memos, then you could tell ISYS to make the title the 
first line, that occurs after the third, in the document that contains the string "Re:".    If 
you change this option, you will need to reindex your database for it the change to take 
affect.

Hypertext/Front Page
The front page feature provides a method of informing your users about the contents of 
the database and the ability to provide links to other documents, via queries, embedded 
links, images, etc.    In many instances this feature may replace the use of a concept 
tree.    All you need do is set up a document with all the links you want, and declare it to 
be your front page
The front page document should be stored in your ISYS database directory, and its 
filename entered here EXACTLY as it appears in the databse directory.    Once a front 
page has been declared a new menu option appears in the ISYS query program and a 
button is available for selection on the Main toolbar.
See Also:



ISYS Utilities
Setup Wizard
File formats
Indexing rules
Database overview



Common words (maintaining)
To edit the common word list, click on the Options menu from the ISYS Utilities menu. 
ISYS shows you the Database Options window with groups of options arranged in card 
tab form.    Choose the tab of the group Characters & Words.    Click on the Edit List 
button.    ISYS will show you the Common Word List window.
Make the changes to the common word list.
After making changes to common words, you have to reindex the database for the new 
common words list to take effect.
See Also:
Database options
Common words (viewing)



Restrictions
The restrictions option restricts users to particular directories, or limits the functions they
have access to with the ISYS Query program.
To set up restrictions, click on the Restrictions option from the ISYS Utilities window. 
ISYS shows you the Restrictions window. Enter the options you want and click on the 
OK button to save them. 
The options are:

Constrain user files in and under
Type the directory name that you want to restrict user to. If you do not the know the 
directory name, click on the Browse button. ISYS shows you the Constrain users to 
window, where you can select the drive and directory that you want to restrict the user 
to.

Print line limit
By default this option is set to No limit.    Should you wish to limit your users to printing a 
specific number of lines, just enter the appropriate number in the Print Line Limit box.    
If you wish you can disallow printing completely by checking the No Printing box.

Feature access
By default, all these options are available to users when you first install ISYS. To restrict
an option, click on the check box such that it is not selected. If a check box has a cross 
in it, then users have access to that feature.

Document activation
Whether users can activate the document in its application.

Synonym editing
Whether users can edit synonyms.

Saved query editing
Whether users can edit the saved query list.

Annotation editing
Whether users can annotate documents in IQ Browse.

Document file copying
Whether users can copy the entire file using the File menu Copy item.

Switch between database catalog/directory
Whether users can alternate between the catalog (if created) and the directory tree. 

Catalog Editing 
Whether users are able to edit the database catalog .





Auditor
The auditor logs the activities of ISYS Query users. You can select what activities you 
wish to have logged.
From the ISYS Utilities window, click on the Auditor menu and ISYS will show you the 
Auditor Options window. Enter the options you want and click on the OK button to save 
them. 
The options are:

ID information
Log File

This is the name of the file that the auditor sends the activity log to. All users must have 
read/write access to this file. ISYS keeps adding information to the same log file until 
you delete the file. You can use DOS environment variables by enclosing the variable 
name in curly braces, e.g. "{LOGFILE}".

User Ident
This is the information which identifies each user of ISYS in the log file. If you are the 
only user, type your name in here. You can include DOS environment variables by 
enclosing the variable name in curly braces, e.g. "{USR}".

Master Control
This controls whether the auditor is on or off.

Audit events
Select what types of user activity you want to be added to the log file. To log an activity, 
click on the check box so that the box is selected. The options are:

Queries
This logs the query commands that users run.

Results of queries
Logs the result of all the queries that users run. This will also list how many hits per 
query.

Errors
Logs all the error messages that ISYS produces.

Documents browsed
Logs the number of times and the name of documents that    users viewed using the 
ISYS document viewer.

Document activated with WP
Logs the number of times and the name of documents users viewed using a word 
processing package.

Document annotated



Logs annotations users enter into documents using the ISYS document viewer.
Program loads/unloads

Logs when a user starts or quits ISYS Query.
Database opens

Logs the databases which have been queried.



Filters
The filters allow you to configure ISYS to only display particular documents in the 
document list.
To filter the query results, click on the Filter button. Alternatively, select the File menu, 
and then the Filter Results item, or you can press CTRL-F on your keyboard. 
The Filter window is displayed to you. The drop down boxes on the fields in the Filter 
window allow you to choose from earlier filter settings.
See Also:
Filter options reference
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Filter options reference
File path contains

Type the string that the file path must contain for the document to be displayed. You 
can enter multiple entries delimited by a semicolon.

File path omits
Type the string that the file path must not contain for the document to be displayed. You
can enter multiple entries delimited by a semicolon.

File name like
Type the MS-DOS file specification which documents must match to be displayed. You 
can also enter multiple entries delimited by a semicolon.
For more information on MS-DOS file naming conventions, and wildcards, see your MS-
DOS and Windows manuals.

File name unlike
Type the MS-DOS file specification which documents must match to be displayed. You 
can also enter multiple entries delimited by a semicolon.
For more information on MS-DOS file naming conventions, and wildcards, see your MS-
DOS and Windows manuals.

File date from; To
To only include files between certain dates, enter the dates into the "File Date From" 
and "To" fields. The dates are inclusive.
See Also:
Filters
Adding a concept



Command-based operator reference
The following is a list of the operators you can use in your queries. Although they are 
written here in all capitals, it is not necessary to enter them as such.

AND
The AND operator is used to locate documents which contain both of the entered words 
or phrases anywhere in the text of the document.

OR
The OR operator is used to locate documents which contain any one of the entered 
words or phrases.

NOT
The NOT operator is used to locate documents which contain the first word or phrase, 
but not the second.

XOR
The XOR operator is used to locate documents which contain either the first word or 
phrase, or the second, but not both.

EXCEPT
The EXCEPT operator is used to locate documents in which the first word or phrase 
appears, but only if the second term or phrase is not in the same paragraph as the first. 
This is a more specific version of NOT.

...
The FAR FOLLOW operator is used to locate documents where the first word or phrase 
is subsequently followed by the second. That is, both words or phrases occur in the 
document, but the second one must occur after the first.

..
The CLOSE FOLLOW operator is used to locate documents where the first word or 
phrase is followed by the second word or phrase in pairs.

\x,y\
The IN PARAS operator is used to locate documents where both words or phrases 
occur within the specified number of paragraphs of each other. 
You can use the form "\\" to specify "within a paragraph of". You can also specify 
negative paragraph numbers.
The default for x is 1, and y defaults to -x.

/x,y/ or W/n
The NEAR BY operator is used to locate documents where both words or phrases 
appear in the same paragraph, within the number of words specified by x and y, or n (in
the second case). 
You can use the form "//" to specify "in the same paragraph".
The default for y is the end of the paragraph, and the default for x is -y (i.e. the 
beginning of the paragraph). You can also specify negative ranges.



IN
The IN operator is used to locate documents which contains the first word or phrase in a
paragraph that is labelled with the second word or phrase.

LABEL
The LABEL operator is used to find documents which contain a paragraph that is 
labelled with the word or phrase.

TO
The TO operator specifies an alphabetic or numeric range. The TO operator can be 
used to search for dates if they are expressed in YYMMDD format.

AFTER
For use in conjunction with the Intelligent Date Handling option, this operator allows you
to search for any documents containing dates After a specific date.

BEFORE

For use in conjunction with the Intelligent Date Handling option, this operator allows you
to search for any documents containing dates Before a specific date.

See Also:

Special Symbols

Adding a concept
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Special symbols * ! ~ +
There are a number of special symbols which change the meaning of the commands 
entered in a query. They are:

* or !
The "*" or "!" symbols tell ISYS to find any number of significant characters. They are 
similar to the DOS wildcard character. The wildcard * can also be used at the beginning 
of a word, however only one wildcard can be used per word.    Note that the amount of 
time to complete the query will increase as the position of the * moves toward the left.

~
The "~" symbol tells ISYS to apply conflation to a word.
By default conflation is set to off in the Preferences section of ISYS Query.    Using this 
symbol in a query will turn it on for this word.    If you change your preference so that 
conflation is always turned on, use this symbol to turn conflation off.
You can also use the conflation operator at the beginning of a word, or at both ends of 
word.

+
The "+" symbol is the toggle switch for the synonym expansion setting.    When you 
enter a word into a query that is defined in a synonym ring, depending on this operator 
and the automatic synonym setting in the Preferences window, ISYS will also search for
all the other words in the ring.
By default, synonyms are turned on in the Preferences section of ISYS Query.    If 
synonym expansion is on, using this symbol in a query will turn it off just for this word, 
and vice versa.

See Also:

Command-based operator reference
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File menu
Select Database

Allows you to change the database you are working with
Setup Wizard

Activates the Setup Wizard facility
File Types

Displays the File Formats window
Indexing Rules

Displays the Indexing Rules window
Exit

Exits ISYS Utilities



Utilities menu
Create

Creates the database files
Preview

Allows you to preview the next update
Reindex

Reindexes the database
Optimize

Optimizes the database for optimum access time and index file size
Statistics

Displays statistics about the database
Add

Add incorporates references to the database for new documents only
Word Frequency

Displays the word frequency list
Document List

Displays the list of documents in the database
Common Words

Displays the common word list
Users

Displays ISYS users
ISYS Scheduler

The ISYS Scheduler allows you to have ISYS automatically Update, Reindex or 
optimize your database.



ISYS Scheduler
The ISYS Scheduler allows you to have ISYS automatically Update, Reindex or 
Optimize your database.    From Utilities menu of the ISYS Utilities program, select the 
ISYS Scheduler option.
To schedule an activity choose the Add button and ISYS will display the Scheduled 
Activity Window.    Select the type of activity for scheduling, the name of the database 
and optionally the log file you wish to use.    
Enter the time of day for the activity to be performed and the day(s) of the week on 
which it should be performed.    Choose OK to return to the Scheduler window.
If you want ISYS to prompt you before performing the scheduled item, check the 
appropriate box.
Once the scheduler is activated, it will only actually perform the task if ISYS Utilities is 
loaded.    Check the appropriate box if you want the Scheduler to resume when ISYS 
Utilities is loaded.
Activate the Scheduler by checking the Scheduler Currently Active box.
See Also:
Update
Reindex
Optimize





Operator - a word or symbol such as AND or OR used in a query, which ISYS treats 
differently from the rest of the query text



Synonyms - words which have similar meaning



Synonym expansion setting - a setting in the Preferences Window which tells ISYS 
whether to automatically search for the words entered in synonym rings.



Synonym rings - ISYS stores a synonym as a series of words in a ring. If any word in a
ring is entered in a query, then any occurrences of the other words in the ring are also 
found by the query.



Document list - The document list shows you the documents which match your query. 



Hit List - The hit list shows you each of the words in your query ISYS found, and the 
total number of matches for that word. 



Paragraph - For word processor files, a paragraph is considered to end at the next hard
return. For ASCII files, a paragraph is up to the next blank line (i.e. two carriage returns 
in a row).



Significant characters - characters which are included in the ISYS database and are 
treated as an important part of any word in which they appear. E.g if the hyphen is 
defined as significant, then "nucleic-acid" is indexed as "nucleic-acid"



Insignificant characters - characters which are not included in the database and 
treated as if non-existent. E.g if the hyphen is defined as insignificant, then "nucleic-
acid" is indexed as "nucleicacid".



Punctuation characters - characters which are neither significant or insignificant and 
are treated as the end of a word and the start of another. E.g if the hyphen is a 
punctuation character, then "nucleic-acid" is indexed as two words - "nucleic" and "acid".



Word tense conflation - conflation allows ISYS to find different tenses of a word, e.g. 
"build", "built", "building".



Command-based query - a query which is typed directly into ISYS using the built in 
command language.



Saved query list - a list of commonly run queries which are stored in a list for easy 
recall.



Preferences - a number of settings which enable you to customize ISYS operation.



Hits - words which match the query you have entered



Hit in context -    a word which matches the query you entered displayed with the words
which occur around it (in its "context").



Filters - a way to make ISYS display only certain documents it finds to you in the 
document list.



Query Results - the documents and words which are found by your query, displayed to 
you as the document and hit lists in the ISYS Query window.



File Path - the MS-DOS directory path to the document



File Name - the MS-DOS file name of the document



Annotations - extra information you can add to a document, which can then be viewed 
or run by clicking on the symbol which is inserted into the text in IQ Browse.



Text note - a text annotation. When you click on the symbol in IQ Browse you see the 
text in a window.



Graphic Image - a picture annotation. When you click on the symbol in IQ Browse you 
see the graphic in a window.



Hyperactivity - an annotation which is a program that is activated when you click it.



Embedded Queries - attaching or linking a query allows you to store a query in the 
ISYS browse screen that may be relevant to the text displayed. 



Hyperlinks - allow you to create links between documents that you consider to be 
related.



Query - a query is the process of telling ISYS what you want to find.



Document - documents are the files on your computer or in your network which contain
information that is included in the ISYS database. Documents may be almost any type 
of file (e.g. spreadsheet or database), but are usually word processor files or plain text.



Hypertext query - the query is first stripped of any common words or operators, and 
word tense conflation is also turned on for each remaining word before being passed to 
ISYS to run.



Exact query - the query is passed to ISYS as is, with no prior processing for operators 
or common words, etc.



Common Word - a word that is defined as commonly occurring in your documents, 
excluded to save disk space and unnecessary matches.



Label - the words a paragraph starts with



Document Titles - a specified line in each document can be defined to be the title of 
the document.



Database - ISYS stores the index to your documents in a database. Queries are run 
against the database rather than searching your disk for documents.



Rules - Rules tell ISYS which documents to include in or exclude from your database



Exclude rule - a rule that tells ISYS not to include the document in the database.



Reverse chronological order - from newest to oldest



Chronological order - from oldest to newest



Ventura Publisher - a desktop publishing program which inserts special markers into 
documents for the control of formatting. If alerted to their presence, ISYS knows how to 
handle with the markers.



Dos Environment Variable - a special command used in DOS with the SET = 
command. See your DOS manual for further detail.



Document format - the type of file the document is, determined by its application, e.g. 
Word for Windows .DOC document, dBase .DBF database, etc.



Catalog - a catalog of databases provides the user with an easy way to select a 
database for querying, rather than navigating the directory tree to locate where the 
database resides.



Index Files - An ISYS database is contained within the index and configuration files i.e.,
ISYS.IXA, ISYS.IXB, ISYS.IXC and ISYS.CFG.    Where these files reside is known as 
the database root node.



Fuzzy precompensation - ISYS uses sophisticated heuristical, algorithmic and 
statistical means to determine which words are likely errors of other words.    When the 
option is active ISYS queries will automatically and transparently retrieve words that it 
considers may be OCR scanning errors or other typographical errors.




